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Preface
The Informatica Connector Toolkit Getting Started Guide provides information about the Informatica 
connector toolkit and how to use it to develop adapters for Informatica. The Informatica connector toolkit 
provides a MySQL adapter sample source code that you can use to develop an adapter.

This guide assumes you have a working knowledge of Informatica services and Informatica Cloud and are 
familiar with data sources, ODBC, JDBC, and application programming interfaces.

Informatica Resources

Informatica Network
Informatica Network hosts Informatica Global Customer Support, the Informatica Knowledge Base, and other 
product resources. To access Informatica Network, visit https://network.informatica.com.

As a member, you can:

• Access all of your Informatica resources in one place.

• Search the Knowledge Base for product resources, including documentation, FAQs, and best practices.

• View product availability information.

• Review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

As a member, you can:

• Access all of your Informatica resources in one place.

• Search the Knowledge Base for product resources, including documentation, FAQs, and best practices.

• View product availability information.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to search Informatica Network for product resources such as 
documentation, how-to articles, best practices, and PAMs.

To access the Knowledge Base, visit https://kb.informatica.com. If you have questions, comments, or ideas 
about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.

6
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Informatica Documentation
To get the latest documentation for your product, browse the Informatica Knowledge Base at 
https://kb.informatica.com/_layouts/ProductDocumentation/Page/ProductDocumentSearch.aspx.

If you have questions, comments, or ideas about this documentation, contact the Informatica Documentation 
team through email at infa_documentation@informatica.com.

Informatica Product Availability Matrixes
Product Availability Matrixes (PAMs) indicate the versions of operating systems, databases, and other types 
of data sources and targets that a product release supports. If you are an Informatica Network member, you 
can access PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional 
Services. Developed from the real-world experience of hundreds of data management projects, Informatica 
Velocity represents the collective knowledge of our consultants who have worked with organizations from 
around the world to plan, develop, deploy, and maintain successful data management solutions.

If you are an Informatica Network member, you can access Informatica Velocity resources at 
http://velocity.informatica.com.

If you have questions, comments, or ideas about Informatica Velocity, contact Informatica Professional 
Services at ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that augment, extend, or enhance your 
Informatica implementations. By leveraging any of the hundreds of solutions from Informatica developers 
and partners, you can improve your productivity and speed up time to implementation on your projects. You 
can access Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center by telephone or through Online Support on Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at 
the following link: 
http://www.informatica.com/us/services-and-training/support-services/global-support-centers.

If you are an Informatica Network member, you can use Online Support at http://network.informatica.com.
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C h a p t e r  1

Introduction to Informatica 
Connector Toolkit

This chapter includes the following topics:

• Informatica Connector Toolkit Overview, 8

• Informatica Connector Perspective, 9

• Analyze the Data Source, 10

• Adapter Example: MySQL, 10

• Building an Adapter, 10

Informatica Connector Toolkit Overview
Use the Informatica Connector Toolkit to build an adapter that provides connectivity between a data source 
and PowerCenter®, Big Data Management®, or Informatica Cloud®.

Although Informatica supports generic ODBC connectivity and allows access to any data source that has a 
standards-compliant ODBC driver, building an adapter by using the Informatica Connector Toolkit offers 
several advantages. In cases where no ODBC driver is available, building an adapter by using the Informatica 
Connector Toolkit might be the only solution.

When you use the Informatica Connector Toolkit to create an adapter, you can build functionality related to 
the data source. You can preserve data type integrity and metadata lineage of the data source when you 
retain the type system of the data source and perform optimal data type conversions.

The Informatica Connector Toolkit consists of libraries, plug-ins, and sample code to assist you in developing 
adapters for PowerCenter, Big Data Management, or Informatica Cloud. You can use the Informatica 
Connector perspective in the Eclipse IDE to quickly develop an adapter in an Eclipse environment.

The Informatica Connector Toolkit simplifies the following processes:

• Development. You can use the wizards in the Informatica Connector perspective to rapidly develop an 
adapter. The wizards simplifies the use of internal components and dependencies when you develop an 
adapter.

• Testing. After you define the adapter components, you can test the connection, metadata, and run-time 
components of the adapter.

• Deployment. You can deploy the adapter on local Informatica services and clients and register the adapter 
on local Informatica services. Alternatively, you can publish the adapter and manually deploy the adapter 
later.
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The Informatica Connector Toolkit API is written in a combination of C/C++ and Java. The connection 
definition and metadata definition are available in Java. The run-time interfaces are available in C/C++ and 
Java.

Note: Run-time interfaces are available in C/C++ when you develop adapters for Big Data Management. Run-
time interfaces are available only in Java when you develop connectors for Informatica Cloud and 
PowerCenter.

Informatica Connector Perspective
The views in the Informatica Connector perspective enable you to develop adapters for the Informatica 
platform and connectors for Informatica Cloud.

After you click the Create New Connector icon in the Eclipse Workbench toolbar, you can choose to switch to 
the Informatica Connector perspective. You can also open the Informatica Connector perspective from the 
Window menu in the Eclipse IDE.

The Informatica Connector perspective consists of the Connector Navigator view and Connector Progress 
view in the Eclipse Workbench window, and icons in the Eclipse toolbar. You can use the Connector Navigator 
and Connector Progress views to define, edit, or test the adapter components and view the progress of the 
adapter project. Use the Create New Connector icon in the Toolbar to create an adapter project. You can use 
the View or Create Messages icon in the Eclipse toolbar to view or create messages for the adapter 
components.

Connector Navigator
You can use the Connector Navigator view to add, define, edit, or test adapter components, such as 
connection, metadata, and run time.

After you create an Informatica Connector project, you can right-click folders in the Connector Navigator view 
to define, edit, or test adapter components. You can also right-click the adapter source files and edit them in 
the Eclipse Workbench editor or any other editor.

Connector Progress
You can use the Connector Progress view to view the completeness of the connector project and to define or 
edit the connector project components in each phase.

The Connector Progress view consists of the following phases:

Connectivity

You can define, edit, or test the connection component of an adapter in the Connectivity phase.

Metadata

You can define and edit data types and native metadata object components of an adapter in the 
Metadata phase. You can also define common metadata for Informatica Cloud connectors in the 
Metadata phase. You can test the adapter metadata components in the Metadata phase.

Runtime

You can define, edit, and test the adapter run-time components in the Runtime phase.
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Export/Publish

You can publish the adapter to a location or deploy the adapter on local Informatica services and client 
directories in the Export/Publish phase.

Analyze the Data Source
Before you develop an adapter for a data source, perform a detailed analysis of the data source.

Analyze the following aspects of the data source:

• Connection attributes that you need to connect to the data source.

• Informatica platform data objects that you need to create to read data and write data.

• Native data types and the possible mapping to the Informatica platform data types.

• APIs available for the following tasks:

- Validate connection attributes and connect to the data source

- Browse metadata from the data source

- Read from or write to the data source

• Additional configuration attributes that you require to read or write data to the data source.

Adapter Example: MySQL
You can use the MySQL adapter sample source code in the Informatica Connector Toolkit to develop an 
adapter for MySQL.

Use the MySQL adapter sample source code to read data from or write data to MySQL. To use the MySQL 
adapter sample source code, import the sample projects into Eclipse. Edit the connection, metadata, and run-
time components if required and then publish the adapter bundle.

Note: The MySQL adapter sample source code in the Informatica Connector Toolkit is for illustration 
purposes only.

Building an Adapter
Use the Informatica Connector Toolkit to develop and deploy an adapter for the Informatica platform. You 
can use the Informatica Connector perspective in the Eclipse IDE to rapidly develop an adapter.

To build an adapter with the Informatica Connector Toolkit, perform the following tasks:

1. Install the Informatica Connector Toolkit and set up the Informatica Connector Toolkit Eclipse plug-in.

2. Create an Informatica connector project and define the following components:

• Connection

• Type system
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• Metadata

• Runtime

Before you deploy the adapter, you can test and debug the adapter connection, metadata, and run-time 
components.

3. Publish the adapter bundle or deploy and register the adapter.

4. If you publish the adapter bundle, run the server batch file to deploy and register the adapter with 
Informatica services. Run the client batch file to deploy the client components.
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C h a p t e r  2

Installing and Upgrading the 
Informatica Connector Toolkit

This chapter includes the following topics:

• Installing the Informatica Connector Toolkit Overview, 12

• Before You Begin , 13

• Installation of Eclipse IDE, 13

• Installing Informatica Connector Toolkit on Windows, 14

Installing the Informatica Connector Toolkit Overview
Install the Informatica Connector Toolkit and set up the Informatica Connector Toolkit Eclipse plug-in. To set 
up the Informatica Connector Toolkit Eclipse plug-in, you install the required software on the machine where 
you plan to develop the adapter.

The Informatica Connector Toolkit is part of the Informatica Development Platform (IDP). You can use the 
Informatica Connector Toolkit installer to install the Informatica Connector Toolkit on the machine in which 
you plan to develop an adapter.

You can get the Informatica Connector Toolkit installer from the following sources:

• Informatica Development Platform installation DVD.
Informatica ships the Informatica SDKs on a separate DVD. Run the Informatica Connector Toolkit 
installer to install the Informatica Connector Toolkit on the machine where you plan to do your 
development.

• Informatica electronic software download site.
When you purchase an Informatica product and choose to download the software, you receive a site link, 
user ID, and password to access the Informatica electronic software download site. Follow the 
instructions on the download site to download the Informatica Connector Toolkit installation file.

• Informatica Technology Network.
If you are a registered user of the Informatica Technology Network, you can download the Informatica 
Connector Toolkit installation file from the Informatica Development Platform page. When you download 
the file, the Informatica Development Network provides you with a password. Use this password when you 
extract the files from the download file.

When you run the Informatica Connector Toolkit installer, the installer installs the Informatica Connector 
Toolkit Eclipse plug-in in the Eclipse IDE.
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Before You Begin
Before you develop an adapter with the Informatica Connector Toolkit, you need to install the required 
software and analyze the data source.

Run the Informatica Connector Toolkit installer to install the Informatica Connector Toolkit on the machine 
where you plan to develop the adapter. The Informatica Connector Toolkit contains the binaries, tools, 
samples, and documents that you require to build an adapter.

Install Required Software
Install the following software on the machine where you plan to develop the adapter:

• Eclipse version with support for Plug-in Development Environment (PDE). Informatica Connector Toolkit 
supports the following Eclipse versions:

- Eclipse Kepler 4.2.2 and 4.2.3.

- Eclipse Luna 4.4.2 and 4.4.3.

- Eclipse Mars 4.5.0 M1 and 4.5.1.

- For AIX, Eclipse 4.2.2 and above.

• JDK version 1.8.x.

• Informatica services and clients version 10.1.1 to validate and use the adapter.

• If you implement the adapter run-time behavior in C/C++, install the following software:

- For Windows, MinGW 4.8.1 or later, CMake 3.0.2 or later, and Microsoft Visual C++ 2013.

- For Unix, gcc/g++ 5.2 and CMake 2.6.

- For AIX, gcc/g++ 4.8.2 or later.

• MySQL Connector/J JDBC driver version 5.1.26 or later if you use the MySQL sample adapter.

• YouTube Data API client library for Java version 3 or later if you use the YouTube sample adapter.

Installation of Eclipse IDE
You can install Eclipse IDE on the machine in which you plan to develop the adapter. Use the Eclipse IDE 
package to install Eclipse IDE.

You must install Eclipse version supported by Informatica Connector Toolkit for the Informatica Connector 
Toolkit plug-in to work with the Eclipse IDE.

You can download the Eclipse IDE package from the following location:

http://www.eclipse.org/downloads/
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Installing Informatica Connector Toolkit on Windows
Install the Informatica Connector Toolkit to install the Informatica Connector Toolkit Eclipse plug-in and other 
components that you require to build an adapter.

1. Close all other applications. 

2. Run the install.bat file from the root directory. 

3. In the Welcome page, click Next. 

The Installation Directory page appears.

4. Select the installation directory in which you want to install the Informatica Connector Toolkit. 

5. Select the installation directory in which you installed Eclipse IDE. 

6. Select Install Apache log4j to install the log4j plug-in version that Informatica Connector Toolkit 
requires. The installer installs the required Apache log4j plug-in by default. If you have log4j plug-in 
installed and do not want to install a different version of the library, clear the Install Apache log4j option. 

7. Select Install Apache Commons library to install the commons library that Informatica Connector Toolkit 
requires. 

8. Click Next. 

The Pre-Installation Summary page appears.

9. Click Install. 

The Installing page appears and displays the installation progress.

10. Click Done to complete the installation procedure and then exit the installer. 

Installed Informatica Connector Toolkit Components

After you install the Informatica SDKs, you can find the Informatica Connector Toolkit in the installation 
directory where you installed the Informatica Connector Toolkit.

The Informatica Connector Toolkit installation includes the following components to assist you in developing 
an adapter for the Informatica platform:

• Informatica Connector Toolkit API files. Library files of the Informatica Connector Toolkit API.

• Informatica Connector Toolkit Eclipse plug-in. You can use the wizards and menus that the Informatica 
Connector Toolkit plug-in adds to the Eclipse IDE to develop, test, and deploy an adapter.

• Sample MySQL and YouTube adapters. The sample MySQL and YouTube adapters include source code 
that you can use as a model to build an adapter.

Note: The sample MySQL and YouTube adapters are for illustration purposes only.

• Informatica Connector Toolkit API Reference. Online documentation for the Informatica Connector Toolkit 
API specification.
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C h a p t e r  3

Creating an Adapter
This chapter includes the following topics:

• Creating an Adapter Overview, 15

• Step 1. Create an Adapter Project, 16

• Step 2. Define the Adapter Connection Attributes, 17

• Step 3. Define the Adapter Type System, 23

• Step 4. Define Adapter Metadata, 26

• Step 5. Define Run-Time Interfaces, 33

• Test the Read and Write Capabilities of the Adapter, 34

• Informatica Connector Toolkit Eclipse Plug-in Tip, 38

Creating an Adapter Overview
In this lesson, you create an adapter that enables the Data Integration Service to read data from and write 
data to MySQL.

Lesson Concepts

You can use the Informatica Connector Toolkit Eclipse plug-in to build an adapter to provide connectivity 
between a data source and the Informatica platform.

Create an Informatica connector project for each adapter that you want to build. For each project, you can 
use the Informatica Connector Toolkit Eclipse plug-in to generate the connection, metadata, type system, and 
run-time java source code.

After you create the project, you define the connection. When you define the connection, you configure the 
connection attributes, the connection behavior, and add libraries required by the connection to the project. 
Then, define the type system to configure the adapter data types and how they map to the data types 
supported by the Informatica platform. Then, define the native metadata definition to configure the adapter 
metadata required for the data source operation that you want to implement. Finally, define the run-time 
interfaces. When you define the run-time interfaces, you add run-time libraries to the project and configure 
how the adapter performs each data source operation. You can also test and debug the adapter connection, 
metadata, and run-time components.

Lesson Objectives

In this lesson, you complete the following tasks:

• Create a project for the MySQL adapter.
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• Define the connection attributes for the MySQL adapter and test the adapter connection components.

• Define the type system for the MySQL data types.

• Define a native metadata definition for the MySQL adapter to read and write data.

• Define run-time interfaces to configure how the MySQL adapter performs read and write operations.

• Test the read capability and write capability of the adapter.

Lesson Prerequisites

Before you start this lesson, complete the following prerequisite:

• Install the Informatica Connector Toolkit. For more information, see “Installing the Informatica Connector 
Toolkit Overview” on page 12.

Lesson Timing

Set aside 30 minutes to complete this lesson.

Step 1. Create an Adapter Project
Create a project for the MySQL adapter and define the MySQL adapter properties.

1.
From the Eclipse IDE, click the Create New Connector button (  ). 

The Create Informatica Connector Project dialog box appears.
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2. Enter the following MySQL adapter project details: 

Property Value

Connector ID mysql

Connector Name MySQL

Vendor ID Informatica

Vendor Name Informatica Corporation

Version 1.0.0

Description MySQL sample adapter that demonstrates the Informatica Connector Toolkit capabilities.

3. Click Finish. 

The MySQL adapter project appears in the Connector Navigator view of the Eclipse IDE. 

Step 2. Define the Adapter Connection Attributes
Define the connection attributes to specify the behavior and functionality of the adapter when it connects to 
the MySQL database.

1. In the Connector Navigator view, right-click the project and select Add Connection. 

The Add Connection dialog box appears.

2. Enter MySQL for the connection type name. 

3. Select Add New and enter Sample for the category name. 

The category name that you configure corresponds the connection object category.
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4. Click Next. 

The Connection Attributes page appears.

5. Click Add to enter each connection attribute. 

The attributes that you configure correspond to the connection object properties.
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The Add Attribute dialog box appears:

a. Enter the following values for the username attribute: 

Property Value

Name username

Display Name User Name

Description The user name to connect to the MySQL database. [Required]

Datatype String

Min Length 0

Max Length 16

Options - Mandatory
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b. Enter the following values for the password attribute: 

Property Value

Name password

Display Name Password

Description The password associated with your user name. [Required]

Datatype String

Min Length 0

Max Length 16

Options - Encrypted
- Mandatory

c. Enter the following values for the host name attribute: 

Property Value

Name hostname

Display Name Host Name

Description Host name of the MySQL server to connect. [Required]

Datatype String

Default Value localhost

Min Length 0

Max Length 16

Options - Mandatory

d. Enter the following values for the port number attribute: 

Property Value

Name port

Display Name Port

Description Port number of the MySQL server to connect. [Required]

Datatype Integer
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Property Value

Default Value 3306

Options - Mandatory

e. Enter the following values for the catalog attribute: 

Property Value

Name catalog

Display Name Catalog

Description Database catalog to connect. [Required]

Datatype String

Min Length 0

Max Length 255

Options - Mandatory

6. Click Next. 

The Configure Libraries page appears.

7. Click Add to select each library that the adapter requires to connect to the MySQL database. 

8. Click Generate Code. 

The Informatica Connector generates Java source code in the Connectivity folder of the adapter project.
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9. In the Connectivity folder of the adapter project, double-click each file to review the source code and 
update it as required. 

Update the following source code files in the Connectivity folder:

MySQLConnectInfoAdapter.java

This file contains optional methods for connection validation and attribute dependencies.

MySQLConnection.java

This file contains methods that open and close the connection to the MySQL service.

Note: If you regenerate code for the connection project, the Informatica Connector Toolkit does not 
regenerate code for the user-exposed source code visible in the Informatica perspective. You have to 
manually edit the source code and make changes if you add, remove, or modify connection attributes.

Test and Debug the Connection to the Data Source
After you define the connection attributes, you can test and debug the connection to the data source.

Create a debug configuration in Eclipse IDE from the Run menu. Select the adapter connection project to 
debug and provide the connection type and connection properties. You can also set breakpoints in the code 
that you want to debug.

After you create a debug configuration, you can launch the Test Connection dialog box to test and debug the 
connection definition.

1. In the Connector Progress view, select Test Connection. 

The Test Connection dialog box appears with the default Java Virtual Machine (JVM) environment 
settings. The Informatica Connector Toolkit uses the JVM settings to run the debug configuration.

2. Edit the JVM environment settings, if required. Ensure that you use the same port number that appears 
in JVM settings for the connection properties in the debug configuration. 

3. Click Next. 

The Connection Details page appears with the connection attributes that you defined for the adapter.

4. Enter values for the connection attributes. 

5. Click Test Connection. 

A success message appears if the connection to the data source is successful.

Note: You cannot use the Informatica Connector Toolkit to test attribute dependencies.
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Step 3. Define the Adapter Type System
Define the type system to specify the datatypes supported by the data source and how they map to the 
datatypes supported by the Informatica platform.

1. In the Connector Navigator view, right-click the project and select Define Typesystem. 

The Define Type System dialog box appears.

2. To manually define a type system that matches the data types in the data source, select Manually Create 
Type System. 

The Define Type System dialog box appears.

3. To map the native data types to the Informatica platform data types, select Native to Platform Type. 
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4. Click Add to configure each type system attribute. 

The Add Type dialog box appears.

a. Enter the following values for the Timestamp attribute: 

Property Value

Type Name Timestamp

Comments Stores a period of time in years, months, days, hours, minutes, and seconds.

Platform Type Date
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Property Value

Max Scale 6

Default Scale 6

Supported Units Year, Month, Day, Hour, Minute, and Second.

b. To map the Informatica Platform DATE data type to the MySQL data type Timestamp as one of the 
Best Native Type to Write, select Mapped in the DATE row and then select Best Native Type to Write. 

c. Enter the following values for the Double attribute: 

Property Value

Type Name Double

Comments A double-precision, floating-point number that is accurate to approximately 15 decimal 
places. Permissible values are -1.7976931348623157E+308 to 
-2.2250738585072014E-308, 0, and 2.2250738585072014E-308 to 
1.7976931348623157E+308.

Platform Type Double

Max Precision 15

Default Precision 15

Precision Radix Decimal

Max Exponent 11

Min Exponent 0

Exponent Radix Binary

d. To map the Informatica Platform Double data type to the MySQL data type Double as one of the 
Best Native Type to Write, select Mapped in the Double row and then select Best Native Type to 
Write. 

e. Enter the following values for the String attribute: 

Property Value

Type Name String

Comments Variable-sized field of characters.

Platform Type string

Max Length 8000
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Property Value

Default Length 50

Length Unit characters

Restrictions Allow Length Modifications and Allow Variable Allocation.

f. To map the Informatica Platform string type to the MySQL data type String as one of the Best Native 
Type to read, select Mapped in the String row and then select Best Native Type to Read. 

5. Click Generate Code. 

Step 4. Define Adapter Metadata
Define the MySQL adapter metadata. Create a native metadata definition for the MySQL adapter to read from 
and write to MySQL data source.

1. In the Connector Navigator view, right-click the project and select Add Native Metadata Definition. 

The Add Native Metadata Definition dialog box appears.

2. Enter the native metadata details. 

The following table describes the values to enter:

Property Value

Name table

Display Name Table

Description Represents a MySQL table.

Pattern Type Record

3. Select Add Record Extension. 

4. Click Add to configure each attribute. 

26       Chapter 3: Creating an Adapter



The Add Attribute dialog box appears.

a. Enter the following values for the queryHint attribute: 

Property Value

Name tableType

Display Name Table Type

Description Represents the type of record.

Data Type String

Min Length 0

Max Length 255

b. Click OK. 

The Add Native Metadata Definition dialog box appears.

5. Click Next. 

The Native Metadata Field Definition page displays.
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6. Select Add Field Extension. 

7. Click Add to configure each attribute. 

a. Enter the following values for the isNullable attribute: 

Property Value

Name isNullable

Display Name Is Nullable

Description Indicates whether the column can contain null values.

Data Type Boolean

Default Value True

b. Enter the following values for the ColumnDefaultValue attribute: 

Property Value

Name ColumnDefaultValue

Display Name ColumnDefaultValue

Description Indicates the default values that the column can contain.

Data Type String

Min Length 0

Max Length 255

c. Click OK. 

The Native Metadata Field Definition dialog box appears.

8. Click Next. 

The Native Metadata Read Capability page appears.
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9. Select Enable Read Capability. 

10. Select the following options: 

• Required in the Lookup section.

• Filter in the Join and Filter section.

• Platform as the type of Filter.

• Sort in the Sort and Select section.

Implement the initDataAdapter API in the MysqlDataAdapter.java file to add the lookup, filter, and sort 
logic.

11. Click Add to configure each attribute. 

The Add Attribute dialog box appears.

a. Enter the following values for the preSQL attribute: 

Property Value

Name preSQL

Display Name Pre-SQL
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Property Value

Description SQL queries to run before the adapter reads data from the source.

Data Type String

Min Length 0

Max Length 255

Supports Parameter Partial Parameterization

b. Enter the following values for the rowLimit attribute: 

Property Value

Name rowLimit

Display Name Row Limit

Data Type Integer

Min Length 0

Max Length 10

Supports Parameter No

Options Override Partition

c. Enter the following values for the rowLimit attribute: 

Property Value

Name postSQL

Display Name post SQL

Data Type String

Min Length 0

Max Length 255

Supports Parameter Partial Parameterization
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d. Enter the following values for the rowLimit attribute: 

Property Value

Name rowOffset

Display Name Row Offset

Data Type Integer

Min Length 0

Max Length 0

Supports Parameter Full Parameterization

Options Override Partition

e. Click OK. 

The Native Metadata Read Capability dialog box appears.

12. Click Next. 

The Native Metadata Write Capability page displays.

13. Select Enable Write Capability. 

14. Click Add. 

The Add Attribute dialog box appears.

a. Enter the following values for the truncateTargetTable attribute: 

Property Value

Name truncateTargetTable

Display Name Truncate Target Table

Description Indicates whether to truncate the target table before starting the write operation.

Data Type Boolean

Default Value False
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b. Enter the following values for the partitionID attribute 

Property Value

Name partitionID

Display Name Partition ID

Data Type String

Min Length 0

Max Length 50

Supports Parameter No

Override Partition -Override Partition

15. Click Next. 

The Native Metadata Partitioning Capability page appears.

16. To specify partitioning capability for the native metadata object, select the following options: 

a. Select Supports Partitioning Capability for Read to enable the partition capability for the read 
operation. 

b. Select Dynamic to specify the partitioning method for the read operation. 

c. Select Supports Partitioning Capability for Write to enable the partition capability for the write 
operation. 

d. Select Dynamic to specify the partitioning method for the write operation. 

Extend the AutoPartitioningMetadataAdapter class to implement the partition logic.

17. Click Next. 

The Import Dialog Box Settings page appears.
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18. To define the import options that appear in the Developer tool when an adapter consumer creates a data 
object, select the following options: 

• Select the Allow Multi Select option to allow the adapter user to select multiple importable objects.

• Select the Display Filter By Name option to display the filter by name option.

• Select the Show Entity option to show the entity details.

19. Click Generate Code. 

The Informatica Connector generates source code in the Metadata and Runtime folders of the adapter 
project.

20. In the Metadata folder of the adapter project, double-click the MySQLMetadataAdapter.java file to review 
the source code and update it as required. MySQLMetadataAdapter.java contains methods for importing 
metadata. 

Provide code for the following methods:

• populateObjectCatalog()
• populateObjectDetails()
For more information about these methods, see the Informatica Connector Toolkit API Reference.

Test Metadata from the Data Source
After you define the native metadata objects, you can test metadata that you import from the data source.

To debug when you test metadata from the data source, use the same debug configuration that you used to 
test the connection to the data source. You can also set breakpoints in the code that you want to debug.

After you define the debug configuration, you can launch the Test Metadata dialog box to test the connection 
definition and test the metadata import from the data source.

1. In the Connector Progress view, select Test<NMOName> under the Test Metadata section. 

The Test Metadata dialog box appears with the connection attributes that you defined for the adapter.

2. Enter values for the connection attributes to connect to the data source. 

3. Click Connect. 

The adapter retrieves the metadata from the data source and the metadata appears in the Test 
Metadata page.

4. Browse and verify the retrieved metadata. 

5. Click Close. 

Step 5. Define Run-Time Interfaces
Use the run-time interfaces available in C to specify how the MySQL adapter reads and writes comments.

1. In the Connector Progress view, right-click the project and select Runtime > Set Up. 

The Run-time Implementation wizard appears.

2. Select Implement in C and click Next. 

The Supported Platforms page appears.

3. Click Add. 
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The Add Platform page appears.

4. Select NT as the platform. 

5. In the Compile section, click Add. The Add Directory dialog box appears. 

a. Browse to the location that contains the library files required for the MySQL adapter. For example, 
browse to C:\mysql-connector-c-6.1.5-winx64\mysql-connector-c-6.1.5-winx64\include. 

b. Click OK to add the include paths. 

6. Ensure that Visual Studio is selected as the IDE for the run-time project. 

7. In the Link section, click Add. The Add Library dialog box appears. 

a. Browse to the directory that contains the link library files required for the MySQL adapter. For 
example, browse to C:\mysql-connector-c-6.1.5-winx64\mysql-connector-c-6.1.5-
winx64\lib. 

b. Click OK to add the library paths. 

8. Click OK to return to the Supported Platform page. 

9. Click Finish. 

The Run-time Implementation wizard generates the C project files in the runtime folder.

10. Use Visual Studio to open the C++ project in the Runtime folder of the table NMO and implement the 
following functions: 

• INFAADPInitPlugin

• INFAADPDeinitPlugin

• INFAADPInitDataSourceOperation

• INFAADPDeinitDataSourceOperation

• INFAADPInitdataSession

• INFAADPDeinitDataSession

• INFAADPBegindataSession

• INFAADPEndDataSession

• INFAADPDisConnect

• INFAADPConnect

• INFAADPRead

• INFAADPWrite

For more information about these methods, see the Informatica Connector Toolkit API Reference.

Test the Read and Write Capabilities of the Adapter
Before you deploy the adapter in the Informatica domain, you can test the read and write capabilities of the 
adapter.

After you define the adapter run-time components, you can use the Test Read and Test Write wizards to test 
the read and write capabilities of the adapter. After you debug and fix issues in the read and write capabilities 
of the adapter, you can deploy the adapter in the Informatica domain.

You can test the read and write capabilities of the adapter only for the Windows platform.
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Test the Read Capability of the Adapter
When you test the read capability of the adapter, you test the connection definition, metadata of the data 
source, and operations that the adapter supports. After you specify the test settings and run the test, you can 
view the result of the read operation, read operation statistics, and the log file.

To debug the code, use the same debug configuration that you used to test the connection and metadata 
components of the adapter. You can also set breakpoints in the code that you want to debug.

After you define the debug configuration, you can launch the Test Read dialog box to test the read 
capabilities of the adapter.

1. In the Connector Progress view, select the native metadata object that appears under Test Read. 

The Test Read dialog box appears with the default JVM environment settings and tracing level. The 
Informatica Connector Toolkit uses the JVM settings to run the debug configuration.

2. If required, edit the JVM environment settings. Ensure that you use the same port number that appears 
in JVM settings for the connection properties in the debug configuration. 

3. Select the required tracing level. The default is normal. Based on the amount of detail that you require in 
the log file, you can override the default tracing level. 

You can set the following types of tracing level:

None

Does not override the default tracing level.

Terse

Logs initialization information and error messages and notification of rejected data.

Normal

Logs initialization and status information, errors encountered, and skipped rows due to 
transformation row errors. Summarizes mapping results, but not at the level of individual rows. This 
is the default tracing level.

Verbose Initialization

In addition to normal tracing, logs additional initialization details, names of index and data files 
used, and detailed statistics.

Verbose Data

In addition to verbose initialization tracing, logs each row. You can also get detailed statistics on 
where string data was truncated to fit the precision of a column.

4. Click Next. 

The connection attributes that you defined for the adapter appears.

5. Enter values for the connection attributes to test the connection to the data source. 

6. Click Connect. 

The Test Metadata page appears with the metadata imported from the data source.

7. Select the native metadata objects and the corresponding native metadata fields to test the read 
operation. 

8. Click Next. 

Based on whether the selected native metadata object supports join and filter operations, the Join 
Condition page or Filter Condition page appears.

9. If the native metadata object supports join operation, specify an expression in the Join Condition page. 
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• To specify an Informatica platform expression for the join operation, perform the following steps:

1. In the Definition section, select the native metadata object for which you want to specify the join 
condition.

2. To change the join order, click Move Up or Move Down.

3. Specify the join type in Join condition.

4. To define a join condition, select values in the Left Field, Operator, and Right Field columns.

5. To add additional join conditions, click Add.

6. To remove a join condition, select the join condition and click Remove.

• To specify a native expression for the join operation, enter the expression in the Definition section.

10. If the native metadata object supports filter operation, select the Configure Filter option in the Filter 
Condition page and specify the filter condition. 

• To specify an Informatica platform expression for the filter operation, perform the following steps:

1. In the Definition section, click Add to add an Informatica platform expression.

2. In the Field column, select the field to use in the expression.

3. In the Operation column, select a conditional operator to use in the expression.

4. In the Value column, enter a value for the conditional expression.

• To specify a native expression for the filter operation, enter the expression in the Definition section.

11. After you specify expressions for the native metadata object, click Next. 

The Read Capability page appears.

12. Specify values for the read capability attributes and then click Run. 

The Result page appears. You can view the result of the read operation, read operation statistics, and the 
log file in the Result page.

13. Click Close. 

Test the Write Capability of the Adapter
When you test the write capability of the adapter, you test the components of the adapter and write sample 
data to the data source. After you specify the test settings and run the test, you can view the result of the 
write operation, write operation statistics, and the log file.

To debug the code, use the same debug configuration that you used to test the connection and metadata 
components of the adapter. You can also set breakpoints in the code that you want to debug.

After you define the debug configuration, you can launch the Test Write dialog box to test the write 
capabilities of the adapter.

1. In the Connector Progress view, select the native metadata object that appears under Test Write. 

The Test Write dialog box appears with the default JVM environment settings and tracing level. The 
Informatica Connector Toolkit uses the JVM settings to run the debug configuration.

2. If required, edit the JVM environment settings. Ensure that you use the same port number that appears 
in JVM settings for the connection properties in the debug configuration. 

3. Select the required tracing level. The default is normal. Based on the amount of detail that you require in 
the log file, you can override the default tracing level. 

You can set the following types of tracing level:
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None

Does not override the default tracing level.

Terse

Logs initialization information and error messages and notification of rejected data.

Normal

Logs initialization and status information, errors encountered, and skipped rows due to 
transformation row errors. Summarizes mapping results, but not at the level of individual rows. This 
is the default tracing level.

Verbose Initialization

In addition to normal tracing, logs additional initialization details, names of index and data files 
used, and detailed statistics.

Verbose Data

In addition to verbose initialization tracing, logs each row. You can also get detailed statistics on 
where string data was truncated to fit the precision of a column.

4. Click Next. 

The connection attributes that you defined for the adapter appears.

5. Enter values for the connection attributes to test the connection to the data source. 

6. Click Connect. 

The Test Metadata page appears with the metadata imported from the data source.

7. Select a native metadata object to test the write operation. 

The metadata of the native metadata object along with the data type, scale, and precision appears in the 
Test Write page.

8. Select the columns to which you want to write data. 

9. Click Next. 

The Test Data page appears.

10. In the Test Data page, you can load test data from a file or you can generate test data. 

• To load the test data from a file, perform the following steps:

1. Select the Load from a File option. You must load a comma-delimited TXT file or CSV file.

Note: The date and time data types in the file must have the following timestamp format: 
MM/DD/YYYY hh24:mm:ss

2. Click Browse and select the file that contains the test data.

• To generate test data, perform the following steps:

1. Select the Auto generate data option.

2. Enter the number of rows to generate. You can specify a maximum of 1000 rows.

3. Click Generate. The test data appears in the Data Preview section.

4. If required, you can edit the test data that appears in the Data Preview section.

11. After you load a test data file or generate test data, click Next. 

The Write Capability page appears.

12. Specify values for the write capability attributes and then click Run. 

The Result page appears. You can view the result of the write operation, write operation statistics, and 
the log file in the Result page.
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13. Click Close. 

Informatica Connector Toolkit Eclipse Plug-in Tip
Use the following tip when you create an adapter.

Use the Project Explorer view to view the artifacts and packages that the Informatica Connector Toolkit Eclipse Plug-in 
generates.

To display the Project Explorer view, click Window > Show View > Other. Then, expand the General 
folder, select Project Explorer view, and click OK.
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C h a p t e r  4

Publishing and Installing an 
Adapter

This chapter includes the following topics:

• Publishing and Installing an Adapter Overview, 39

• Publish or Deploy the Adapter, 40

• Manually Install the PowerCenter Adapter, 41

Publishing and Installing an Adapter Overview
In this lesson, you will publish and install the MySQL adapter in the Informatica client and server installation 
directories.

Lesson Concepts

Publish the adapter project to bundle the server and client artifacts. The server and client bundles contain the 
files that Informatica requires to create connection objects and access the source data.

Install the server and client bundles in the Informatica client and server installation directories. To install the 
server and client bundles, you can use the publish wizard or you can run the installation scripts.

After you install the server and client bundles, the Data Integration Service can connect to the adapter data 
source and you can create adapter data source connections in the Developer tool and Administrator tool.

Lesson Objectives

In this lesson, you complete the following task:

• Publish the MySQL adapter.

• Install the MySQL adapter.

Lesson Prerequisites

Before you start this lesson, complete the following prerequisite:

• Install the Informatica Connector Toolkit. For more information, see “Installing the Informatica Connector 
Toolkit Overview” on page 12.

• Create a Connector. For more information, see “Creating an Adapter Overview” on page 15.

Lesson Timing

Set aside 10 minutes to complete this lesson.

39



Publish or Deploy the Adapter
You can use the Informatica Connector Toolkit to publish the adapter or to deploy the adapter on local 
Informatica services and client.

1. In the Connector Navigator view, right-click the project and select Publish. 

The Publish Informatica Connector dialog box appears.

2. If you want to publish the adapter, click Browse to configure a location to publish the adapter. 

The Publish Location defaults to the adapter project workspace.

3. To install the adapter on local Informatica services and client machine, complete the following tasks: 

a. Select Publish connector on local Informatica services and client. 

b. Click Browse to configure the local Informatica services and client installation directories. 

c. If you need to reinstall the connector or install a newer version of the connector, select Upgrade. 

4. To view a summary of the artifacts included in the client and server bundles, click Next. 

5. Click Finish. 

If you select the option to deploy the adapter, the Informatica Connector Toolkit installs the MySQL adapter 
on the local Informatica services and the Informatica client. The Data Integration Service can connect to the 
MySQL database and you can create MySQL connections in the Developer tool and Administrator tool. When 
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you display the list of available connection types on the Administrator and Developer tools and the command 
line, the MySQL connection appears in the list.

Manually Install the PowerCenter Adapter
You can manually install the PowerCenter adapter on Windows or Linux after you build the adapter using the 
Informatica Connector Toolkit.

Install the PowerCenter Adapter on Windows (Optional)
To install the adapter on Windows, deploy the adapter to the Informatica services and client installation 
directories. You must also register the adapter to the Informatica services installation directory. If you use 
the Publish connector on local Informatica services and client option to deploy the adapter, you do not need 
to complete these steps.

After you use the Informatica Connector Toolkit to export the adapter, perform the following steps to 
manually install the adapter:

1. Shut down the Informatica domain and Informatica Developer tool applications on which you plan to 
deploy the adapter files. 

2. Perform the following steps to deploy and register the adapter to the server installation directory: 

a. Copy the installServer.bat file and the server folder from the publish location to the machine in 
which you have installed Informatica services. 

b. Launch a command window and navigate to the location of the installServer.bat file. 

c. Run following command in the command window: installServer.bat 
[InformaticaInstallationDir] 
For example, installServer.bat C:\Informatica\10.1.1

d. If you need to reinstall the adapter or install a newer version of the adapter, run the following 
command in the command window: installServer.bat [InformaticaInstallationDir] true 

3. Perform the following steps to deploy the adapter files to the client installation directory: 

a. Copy the installClient.bat file and the client folder from the publish location to the machine in 
which you have installed Informatica client. 

b. Launch a command window and navigate to the location of the installClient.bat file. 

c. Run following command in the command window: installClient.bat 
[InformaticaClientInstallationDir] 
For example, installClient.bat C:\Informatica\10.1.1\clients

d. Run the following adapter registry file: 

For a Windows 32-bit system: m/c:<adapter>.reg
For a Windows 64-bit system: m/c: <adapter>_64.reg
The generated adapter registry file is deployed in the following location:

<deploy>\Informatica_PowerCenter\client\PowerCenterClient\client\bin
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4. Start the Informatica domain. 

The Data Integration Service can connect to the MySQL database and you can create MySQL 
connections in the Developer tool and Administrator tool. The MySQL connection appears when you 
display the list of available connection types in the Administrator tool, the Developer tool, and the 
command line.

Install the PowerCenter Adapter on Linux
To install the adapter on Linux, you must copy the adapter plugins and third-party jars to the installation 
directory. Then, register the adapter to the PowerCenter Repository Service.

To manually install the adapter on Linux, perform the following steps:

1. Copy the adapter plugins from the following directory: 

/deploy/Informatica_PowerCenter/server/server/connectors/cci/plugins
2. Paste the adapter plugins to the following directory: 

<Installation_Directory>/server/connectors/cci/plugins
3. Register the adapter plugin available in the following directory to the PowerCenter Repository Service: 

/deploy/Informatica_PowerCenter/server/server/bin/Plugin
The Data Integration Service can connect to the MySQL database and you can create MySQL connections in 
the Developer tool and Administrator tool. The MySQL connection appears when you display the list of 
available connection types in the Administrator tool, the Developer tool, and the command line.
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A p p e n d i x  A

Frequently Asked Questions
This appendix includes the following topic:

• Informatica Connector Toolkit Frequently Asked Questions, 43

Informatica Connector Toolkit Frequently Asked 
Questions

Review the frequently asked questions to answer questions you might have when you use the Informatica 
Connector Toolkit to develop an adapter.

Can I use the Developer tool to debug an adapter?
Yes. You can use the Developer tool to debug the adapter client components such as connection or 
metadata.

1. Navigate to the Developer client folder. For example, C:\Informatica\version\clients
\DeveloperClient.

2. Edit the developerCore.ini file and add the following Eclipse remote debug options:

-Xdebug
-Xrunjdwp:transport=dt_socket,server=y,suspend=n,address=portnumber

3. Launch the Eclipse IDE and create a Remote Java Application debug configuration.

4. Set the connection type as Standard (Socket Attach), and specify the host and port numbers to connect 
for debugging.

5. Launch the Developer tool.

6. Run the debug configuration in Eclipse after setting required breakpoints in the source files you wish to 
debug.

Can I use the Administrator tool to debug an adapter?
Yes. You can use the Administrator tool to debug the adapter server components.

1. From the Administrator tool, select the Data Integration Service from the navigator and click the 
Properties view.

2. Edit the Execution Options and set the Launch Jobs as Separate Process option to false.

3. Select the Processes view.

4. From Service Process Properties section, edit Advanced Properties.
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5. Append the following Eclipse remote debug options to JVM Command Line Options:

-Xdebug
Xrunjdwp:transport=dt_socket,server=y,suspend=n,address=<portnumber>

6. Launch the Eclipse IDE and create a Remote Java Application debug configuration.

7. Set the connection type as Standard (Socket Attach), and specify the host and port number defined in 
the previous step.

8. Restart the Data Integration Service.

9. Run the debug configuration in Eclipse after setting required breakpoints in the source files you wish to 
debug.

What is the class-loading pattern of the third-party libraries in the Developer tool?
The Developer tool uses the OSGi-based framework for class loading. The Informatica Connector Toolkit 
adds the third-party libraries that the metadata class requires to the metadata adapter bundle class path. If 
the bundle class path is not in use in third-party libraries, analyze the class loading pattern and load classes 
to match the OSGi class loading pattern.

What is the class-loading pattern of the third-party libraries in the Data Integration Service?
The Data Integration Service uses a custom class loader and child first strategy to load the third-party 
libraries for the adapter. The Data Integration Service loads all the classes present in services/shared/* 
directories. Resolve conflicts if the Data Integration Service has loaded classes that conflict with the third-
party libraries.

What must I do if I get the message asking me to check the JDK version even if JDK version 1.7 is 
installed on the machine?
In the Eclipse IDE, navigate to Window > Preferences > Java > Compiler and set Compiler compliance level to 
1.7.

When I generate code for native metadata, I get an error message that project description files 
are out of sync with the file system. Does this error impact code generation?
No. This error does not impact code generation. If you still want to resolve this error, you can select the 
Refresh using native hooks or polling option from the Window > Preferences > General > Workspace menu in 
the Eclipse IDE. If you choose to refresh using native hooks or polling, there may be considerable delay in 
generating code.

Is there a log file that I can refer when I encounter errors while I generate code or publish the 
adapter?
Refer to the <adapter_name>_codebuilder.log file for any errors that you encounter when you generate code 
or publish the adapter. The <adapter_name>_codebuilder.log file is available in the <Eclipse workspace>/
<adapter project> folder.

Can I use the Informatica Connector Toolkit to upgrade an adapter?
Yes. The Informatica Connector Toolkit supports upgrade of an adapter. Use the Upgrade option in the 
Publish Informatica Connector wizard to reinstall or upgrade the adapter.
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Can I use the Informatica Connector Toolkit to deploy an adapter on a worker node?
No. You must manually run the installServer.bat command to deploy the adapter on a worker node. The 
installServer.bat command uses the following syntax:

installServer infa_server_home upgrade skipregistration

Argument Description

infa_server_home Indicates the Informatica services installation directory.

upgrade True if you want to reinstall the adapter, false otherwise.

skipregistration True if you do want to skip registration of this adapter. Set this argument to true if you deploy an 
adapter on a worker node.

After I published an adapter, what must I do if I made changes only to the connection attributes, 
record extensions, field extensions, read capability, or write capability extensions?
If you added attributes, use the Upgrade option in the Publish Informatica Connector wizard to republish the 
adapter. The Informatica Connector Toolkit supports upgrade of an adapter only if the changes are additive. 
If you renamed or deleted any of the existing attributes, uninstall Informatica services, re-create the domain, 
and then install the adapter.

What must I do if the changes that I made to the run-time project are not reflected?
Shutdown the domain, delete the work_dir directory from <InformaticaServicesInstallationDirectory>/
services, and then restart the domain.

What must I do if the Informatica domain is not available after I deploy the adapter?
Ensure that no Informatica services are running in the domain and then redeploy the adapter.

What must I do if the changes that I made to connection attributes or metadata attributes are not 
reflected in the Developer tool?
Run the developerCore.exe command with the -clean option.
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